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Группа 14 Экономика организации Подготовить доклад на тему "Валюты,деньги разных стран мира"

Публикация изучить лекцию «Социальные сети. Определение. Функции и виды». Составить презентацию по теме «Социальные сети. Определение. Функции и виды».
Лекция находится на сайте училища:
Личные странички педагогов – Ясницкая М.П. – ДО – Лекции – лекция ««Социальные сети. Определение. Функции и виды»». 


Учебная практика, 07 февраля, почта tat_2211@mail.ru
Тема 8 Обработка изображения средствами Photoshop
Создание, открытие, сохранение документа в программе растровой графики. Импорт и экспорт изображения. Знакомство с интерфейсом программы. Инструментарий. Палитры. Панель свойств. Строка состояния. Выделение области. Работа с выделенными областями. Растушёвка. Уточнение края. Кадрирование
План:
1. Практическая работа №1. Интерфейс. Выделение
2. Практическая работа №2. Работа с выделенной областью
3. Практическая работа №3. Маски и каналы.
4. Практическая работа. Замена фона
Практическая работа №1
ФОТОШОП
Интерфейс
Открываем программу и видим рабочую обстановку ФШ:
Плавающие панели - слои, каналы, векторные контуры и т.д.
меню
Панель параметров
Панель инструментов. 
За многими пиктограммами скрывается группа инструментов















Если вы случайно закрыли нужную плавающую панель – её легко открыть снова из основного меню Window. 
Для каждого инструмента ФШ имеются свои настройки. Если инструмент выбран, они находятся прямо под основным меню.

Навигация в окне ФШ

Как изображение сделать более мелким или более крупным?
Нажмите клавишу ALT и, не отпуская, вращайте колесо мыши: 
«от себя» - увеличивает масштаб просмотра, «к себе» - уменьшает его.

Если изображение полностью не помещается в окне документа, то как его просмотреть?
Видимую область в этом окне перемещают. Как? Для этого есть специальный инструмент Рука. Чтобы прокрутить окно с его помощью:
1. выберите его на панели инструментов;
1. укажите курсором мыши любую точку изображения;
1. нажмите ЛКМ и, не отпуская её, переместите курсор.
Видимая область сдвинется вслед за курсором.

Чтобы открыть группу инструментов – кликните инструмент группы на панели ПКМ!
Инструмент группы имеет в правом нижнем углу картинку маленького треугольника, активный инструмент обозначен чёрным квадратиком.

Группа инструментов выделения
[image: ]
              инструмент перемещения – это инструмент, который  смещает выделенную область и прекрасно интегрирован с инструментом трансформации.
[image: ]
Инструмент Marquee Tool (Выделение).
С его помощью можно выделить 
произвольный прямоугольник или 
круг (овал), а также колонку или ряд 
шириной 1 пиксель. 
Выделять можно как часть изображения, 
так и пустую область в новом слое — 
для того чтобы залить ее цветом 
или градиентом

Лассо – замечательный и очень 
[image: ]гибкий инструмент выделения. 
Простое Лассо (Lasso Tool) выделяет 
фрагмент изображения именно так, 
как вы его о6ведете мышью.
Полигональное лассо 
(Polygonal Lasso Tool) создаст выделение
на основе заданных вами точек.
Магнитное лассо (Magnetic Lasso Tool) 
привязывается к границе цвета. 
Этот инструмент часто используют при 
вырезании объектов из профессионального 
клипарта, если граница цвета четкая и 
можно позволить себе воспользоваться 
инструментом быстрого выделения.
[image: ]
Инструменты быстрого выделения 
Quick Selection Tool и Magic Wand Tool.
Если вы хотите работать со сколько-нибудь
приличным качеством держитесь подальше
от «волшебных палочек» и прочих 
инструментов с автоматическими настройками.
 Эти инструменты могут дать видимость 
хорошего результата, однако на этапе печати
порой приходится переделывать все с самого 
начала. 
[image: ]
Инструмент             Group – это инструмент, который называется «рамка», с помощью которого можно выделить фрагмент изображения, то есть обрезать лишнее (останется та часть, которая заключена в рамке). На панели настроек под основным меню можно задать размер и разрешение обрезаемой области 
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[image: ]Инструмент                 Нарезка (канцелярский нож, перо) – предназначен для нарезки готовых изображений большого размера для веб – графики.
Группа инструментов рисования
[image: ]Инструмент Восстанавливающие
                      кисти представляет 
собой группу инструментов, 
используемых при фотокоррекции,
восстановлении изображения или
повреждённой текстуры, а также 
для переноса текстуры с одного объекта на другой.

[image: ]Карандаши (Pencil Tool)  и кисти (Brush Tool) 
имеют множество настраиваемых параметров, 
таких как размер, мягкость, прозрачность, форма,
то есть все, что нужно для рисования.


[image: ]	
Инструмент Clone Stamp — это кисть, 
копирующая фрагмент одного рисунка на другой. 
С ее помощью, например, 
можно закрасить бутылку текстурой апельсина. 
Параметры кисти настраиваются:
прозрачность, текстура самой кисти.


[image: ]Инструмент History Brush Tool (Кисть истории) 
предназначен для того, чтобы возвращать 
измененным объектам первоначальный вид. 
Но инструмент работает он не слишком точно.
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Инструмент Eraser Tool (Ластик) 
замечательный и незаменимый 
легко настраиваемый инструмент. 
Главное –  не трогать дополнения.
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Инструмент Paint Bucket Tool 
предназначен для закрашивания фрагментов 
рисунка сплошным цветом. 
Инструмент Gradient Tool  
градиентной заливкой. 
Существует огромное количество настроек 
градиента, его формы и режима смешивания цветов
, что крайне удобно для закрашивания 
как фонового слоя, так и выделенных фрагментов.


[image: ]Инструменты кисти
Sharpen Tool – позволяет увеличить резкость, 
Blur Tool - позволяет уменьшить резкость, 
«палец» (Smudge Tool) — инструмент, 
имитирующий размазывание пальцем.


[image: ]Инструменты Dodge Tool 
осветляет участки рисунка, 
Burn Tool как бы поджаривает,
Sponge Tool убирает излишки цвета, 
как и положено губке 
(то есть это инструменты, позволяющие 
осветлить, затемнить или обесцветить 
изображение, а также добавить тени и объем). 
Это наиболее часто употребляющиеся 
во время рисования инструменты после кисточек. 

Группа векторных инструментов
Инструменты этой группы позволяют создавать векторные контуры любой сложности. 

Инструменты 
Pen Tool строит контур по опорным точкам, 
Freeform Pen Tool создает свободный 
векторный контур, 
Add Anchor Point Tool 
[image: ]позволяет добавить точку контура
Delete Anchor Point Tool 
позволяет удалить точку контура,
Convert Point Tool 
позволяет управлять контуром 
при помощи векторных направляющих.
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Инструмент (обозначен буквой Т) 
предназначен для создания текста. 
Создавать текст ВСЕГДА следует в отдельном слое. 
Любой текст — в первую очередь векторный объект, 
и перед тем как перевести его в растр, 
подумайте, так ли это необходимо?
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Инструмент Path Selection
позволяет быстро редактировать 
векторные контуры.
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Инструмент Custom Shape Tool 
открывает доступ к  встроенной 
библиотеке векторных изображений. 
Собственные векторные контуры 
также можно сохранить и дополнить 
ими библиотеку.
Фигуры можно применять как векторные 
контуры, маски, 
[image: ]и даже просто как растровые изображения. 
Группа вспомогательных инструментов
Добавление комментария. 
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Пипетка, позволяющая брать 
образец из любой точки рисунка.
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Рука, перемещающая рисунок в окне.
[image: ]

                                                                                   Экранная лупа.

Выделение области. Работа с выделенными областями.
Задание № 1. Выделение всего изображения: нажмите комбинацию клавиш CTRL+A. Вокруг изображения появится замкнутая движущаяся прямоугольная рамка в виде штриховой линии. Эту линию называют маркирующим контуром.
1. Откройте файл CHIPDALE.JPG  
1. нажмите CTRL+A
Отмена выделения: нажмите комбинацию клавиш CTRL+D
Задание № 2. Выделение прямоугольной области:
1. выберите инструмент «Прямоугольная область»;
1. расположите курсор мыши в точке, которая будет определять начальную точку выделения – курсор примет вид +;
1. нажмите ЛКМ и, не отпуская её, переместите курсор в конечную точку области выделения – на экране будет видна выделенная прямоугольная область, очерченная штриховой линией.
!!! Инструменты «Горизонтальная строка» и «Вертикальная строка» предназначены для выделения прямоугольных областей фиксированного размера – ширина =1 пикселю, а длина = соответствующей стороне изображения.
!!! Выделение овальной области идентично выделению прямоугольной.
Выделите овальную область самостоятельно – любую.
Выделите квадратную область:
1. выберите инструмент «Прямоугольная область»;
1. расположите курсор мыши в точке, которая будет определять начальную точку выделения – курсор примет вид +;
1. нажмите ALT+ЛКМ и, не отпуская её, переместите курсор в конечную точку области выделения – на экране будет видна выделенная прямоугольная область, очерченная штриховой линией.
Выделите круглую  область:
1. выберите инструмент «Овальная область»;
1. расположите курсор мыши в точке, которая будет определять начальную точку выделения – курсор примет вид +;
1. нажмите ALT+ЛКМ и, не отпуская её, переместите курсор в конечную точку области выделения – на экране будет видна выделенная прямоугольная область, очерченная штриховой линией.
Выделите область произвольной формы: 
отмените все выделения, которые есть на рисунке CTRL+D; выделите одну из фигурок бурундуков (по желанию):
1. выберите инструмент «Лассо»;
1. расположите «конец лассо» в точке, которая будет находиться в месте начала выделяемой области (воображаемого объекта)
!!!чтобы было удобнее нажмите клавишу CapsLock и тогда курсор мыши примет вид «прицела»
1. нажмите ЛКМ и, не отпуская её, не спеша, обведите объект курсором мыши – на экране появится сплошная линия, которая будет повторять движение курсора мыши;
1. доведите курсор мыши до точки начала области выделения, отпустите ЛКМ – сплошная линия превратится в контур выделения.
Выделите область, состоящую из сегментов:
отмените все выделения, которые есть на рисунке CTRL+D;
выделите одну из фигурок бурундуков (по желанию), используя прямолинейные сегменты:
прямолинейные сегменты
1. выберите инструмент «Прямолинейное лассо»;
1. поместите курсор мыши в начальную точку выделения и нажмите ЛКМ один раз;
1. протяните нить прямой линии к следующей точке и снова нажмите ЛКМ один раз и так далее, пока не выделите весь контур;
1. для окончания выделения подведите курсор мыши к начальной точке выделения и дважды щёлкните чтобы автоматически создать последний сегмент и завершить операцию выделения.
отмените все выделения, которые есть на рисунке CTRL+D;
выделите одну из фигурок бурундуков (по желанию), используя криволинейные сегменты:
криволинейные сегменты
Для создания криволинейных участков выполните те же действия, но при этом необходимо держать нажатой клавишу ALT.
!!! Сравните полученный результат.
Выделите область, с помощью «магнита»: используется инструмент «магнитное лассо»
1. выберите инструмент «Магнитное лассо»;
1. поместите курсор мыши в начальную точку выделения (выберите её концом лассо) и нажмите ЛКМ один раз;
1. как можно ближе обведите курсором мыши границу воображаемого объекта (не спеша) и сплошной контур выделения будет точно повторять контур вашего объекта;
для окончания выделения подведите курсор мыши к начальной точке выделения и щёлкните чтобы автоматически завершить операцию выделения
!!! завершить создание области можно и с помощью двойного щелчка.
Инструмент «Лассо» при построении создаёт опорные точки. Чтобы удалит последнюю опорную точку – нажмите клавишу DELETE, таким образом последовательно можно удалить всю линию.
Создание контура выделения с помощью «Волшебной палочки» - автоматически выделяет расположенные рядом одноцветные или схожие по цвету пиксели изображения:
выделите одну из фигурок бурундуков (по желанию):
1. выберите инструмент «Волшебная палочка»;
1. укажите палочкой пиксель нужного вам цвета в предполагаемой области выделения (например, границу изображения одного из бурундуков) и щёлкните ЛКМ один раз – все пиксели, расположенные рядом с выбранным пикселем и имеющие сходный цвет, будут выделены;
1. чтобы добавить к выделенному фрагменту ещё и другие кликните в строке параметров опцию «Добавление к выделенной области» и продолжите выделение.





!!! Работая с данной группой опций на панели параметров, вы можете добавлять или убирать те или иные фрагменты изображения выбирая одну из опций.
Создание контура выделения с помощью инструмента той же группы «Быстрое выделение» -  выделение основано на поиске границы, которую образуют пиксели разного тона (выделяются пиксели изображения, которые находятся вокруг области, выделенной с помощью указателя инструмента):
выделите одну из фигурок бурундуков (по желанию):
!!! размер вашего указателя можно изменить:
1. выберите инструмент «Быстрое выделение»;
1. выберите на панели параметров поле «кисть»;
1. кликните пиктограмму списка, появится диалоговое окно;
1. переместите движок «диаметр» и установите нужный вам размер кисти;
1. щёлкните за пределами окна и вернитесь в картинку.
1. укажите палочкой (курсор принял вид прицела) нужную вам границу области внутри изображения цвета (например, границу изображения одного из бурундуков) и щёлкните ЛКМ один раз – по выбранной границе будет выделен какой то фрагмент изображения;
1. чтобы добавить к выделенному фрагменту ещё и другие кликните в строке параметров опцию «Добавление к выделенной области» и продолжите выделение (расположение опции аналогично предыдущему пункту).
Перемещение рамки выделения
[image: ]выделите одну из фигурок бурундуков (по желанию);
1. выберите на панели инструментов               - курсор мыши примет вид наконечника стрелы с прямоугольником;
2. нажмите ЛКМ и, не отпуская, переместите рамку на новое место;
3. отпустите ЛКМ.
Или клавишами    можно точно перемещать рамку на 1 пиксель.
Отмените все выделения, которые есть на рисунке CTRL+D;
!!! Восстановите картинку, используя Редактирование  Шаг назад столько раз, сколько нужно.
Изменение (трансформация) рамки выделения.
1. Выделите фрагмент картинки (любой, по вашему желанию);
1. Выделение  Трансформировать выделенную область – на экране вокруг выделенной области появится прямоугольная рамка с маркерами;
1. поочерёдно укажите все фрагменты рамки (маркеры и стороны) и зажав ЛКМ произведите перемещение мыши, оцените и проанализируйте полученный результат;
1. для вращения рамки переместите курсор мыши за её пределы и произведите вращение, оцените и проанализируйте полученный результат.
Для того чтобы завершить изменение (т.е. подтвердить) нажмите клавишу ENTER (или Esc чтобы отказаться от произведенных изменений).
Результат: Выделить одного бурундука и сохранить в файле Бурундук.


Практическая работа №2. Работа с выделенной областью
[image: ]Разрешение изображения
Задание № 1. Получите информацию о разрешении и размере изображения.
1. Открыть файл фрукты.jpg.
2. Выполнить команду Изображение Размер изображения. Откроется окно с нужной информацией: 

Щелкнуть на кнопке ОК.
Диалоговое окно Image Size (Размер изображения) позволяет не только узнавать, но и изменять параметры документа.
Задание № 2. Измените разрешение изображения. 
1. Откройте файл фрукты.jpg (если он закрыт);
2. Изображение  Размер изображения  Введите число  20  в  поле  Разрешение.
Обратите внимание, что при уменьшении разрешения изображения уменьшились его размеры в пикселях, а также объем занимаемой памяти (при этом размер печатного оттиска не изменился).  Щелкните на кнопке ОК.
Замечание. Для изменения размеров печатного оттиска нужно ввести новые значения в поля Width (Ширина) и Height (Высота) в разделе Document Size (Размер документа). Флажок Constrain Proportions (Сохранять пропорции) позволяет сохранить пропорции исходного документа.
Основные понятие
Выделенная область — фрагмент изображения, в пределах которого действуют инструменты редактирования. Выделенная область ограничена мерцающей пунктирной линией.
Маскированная область — изображение, расположенное за пределами выделения. Эта область недоступна для редактирования и, следовательно, защищена от случайных изменений.
Инструмент Marquee (Область) предназначен для выделения прямоугольных и эллиптических областей.
Группа инструментов Lasso (Лассо) используется для выделения областей произвольной формы.
Инструмент Magic Wand (Волшебная палочка) — используется для выделения близких по цвету пикселей.
Кадрирование изображения — обрезка изображения (удаление лишних полей, фрагментов окружающей обстановки и т. д.).
Помните!!! 
Прежде чем приступать к созданию следующего выделения, нужно отменить существующее.
Для выделения квадрата или круга необходимо держать нажатой клавишу <Shift>.
Повторение: выделяем области.
 Задание № 3. 
1. Откройте файл дама.jpg;
2. Выберите инструмент Magnetic Lasso (Магнитное Лассо);
3. Выделите область дамы инструментом Magnetic Lasso (Магнитное Лассо); 
4. Увеличьте масштаб изображения (для удобства выделения);
5. Установите курсор в любую точку контура, нажмите ЛКМ и, не отпуская ее, перемещайте курсор по контуру выделяемой области до исходной точки;
6. Замкните контур двойным щелчком мыши.
Замечание. По мере создания границы выделения автоматически ставятся контрольные точки. Если Magnetic Lasso (Магнитное Лассо) неточно определяет нужный контур, можно удалить неверную точку, нажав клавишу Delete и поставить контрольные точки вручную щелчком мыши.
7. Откорректируйте ваш контур выделения, добавив или удалив некоторые контурные точки: отмените выделение и выполните операцию вновь, используя добавление или удаление контурных точек вручную.
8. Закройте документ, не запоминая изменения.
Задание № 4. 	
1. Откройте файл дама.jpg;
2. Выбрать инструмент Волшебная палочка;
3. Выделить область фона инструментом Волшебная палочка:
а) укажите курсором мыши на любую точку фона изображения и нажмите ЛКМ;
б) изображение фона будет иметь нечёткий контур, поэтому добавьте к выделению неохваченные участки:
· на панели параметров назначьте режим Добавление выделенной области и, щёлкая Волшебной палочкой по отдельным выделенным маленьким областям фона, добавьте их к общему фону (выбирая режим Вычитания можно удалять области из выделения – см. ту же панель)

Теперь изображение поделено выделением на 2 части – выделен бегущим штрихом фон и оставшаяся часть изображения – дама. Область оставшейся части изображения (дама) называется маскированной областью (см. определение выше).
4. Поменяйте местами выделенную и маскированную области:
а) Выделить  Инвертировать.
Выделенная и маскированная области поменяются местами. Теперь можно работать с изображением дамы.
5. Закройте документ, не запоминая изменения.
Чтобы вычесть из выделения область, необходимо нажать клавишу <Alt> и, удерживая ее, выделить удаляемую область любым способом
Изменение границ выделенной области
Задание № 5. Откройте файл мальчик.jpg.
1. выделите в качестве области любой глаз мальчика; 
2. Измените границу выделенной области:
а) Выделение  Модификация  Расширить (Сжать).
Откроется диалоговое окно: установите значение расширения (уменьшения) в каждую сторону в пределах от 1 до 100 пикселей – 10, 50, 75. Выделенная область расширится (уменьшится). Проанализируйте полученные результаты. Отмените выделение.
другой вариант:
1. выделите в качестве области кепку мальчика;
 2. Выделение  Трансформировать выделенную область.
Вокруг выделенной области появится рамка с маркерами:
1. Установить курсор мыши на один из маркеров. Курсор примет вид двунаправленной стрелки; 2. Нажать ЛКМ;
3. Перемещать мышь при нажатой кнопке;
4. Отпустить кнопку мыши, когда граница выделения достигнет нужных размеров.
Дважды щелкнуть мышью внутри выделения для завершения операции. 
Замечание. Масштабирование будет пропорциональным, если при перемещении угловых ограничителей держать нажатой клавишу <Shift>.
5. Переместите область выделения на новое место:
а) поместите курсор мыши в область выделения – он примет вид маленькой стрелочки;
б) нажмите ЛКМ и, не отпуская, перемещайте мышь – область будет менять своё местоположение;
в) отпустите ЛКМ, зафиксируйте новое положение области;
Дважды щелкнуть мышью внутри выделения для завершения операции. 
Задание № 6. Выполните вращение границы выделенной области.
1. выделите фигурку всего мальчика;
2. Выделение  Трансформировать выделенную область.
Вокруг выделенной области появится рамка с ограничителями.
3. сделайте выделенную область немного меньше – поместите курсор мыши на марекр любого угла и измените размер выделенной области;
4. установите курсор мыши рядом с маркером с внешней стороны выделения.
Курсор примет вид изогнутой двунаправленной стрелки.
5. нажмите ЛКМ, перемещая мышь при нажатой кнопке, переверните область вверх ногами;
6. отпустить ЛКМ, зафиксируйте новое положение.
Дважды щелкните мышью внутри выделения для завершения операции.
Поворот границы выделения производится относительно центра вращения, который обозначается маленькой окружностью с перекрестием. По умолчанию он находится в центре рамки. Для смещения центра вращения надо:
а) установить курсор мыши на окружность с перекрестьем;
б) нажать кнопку мыши;
в) перемещать мышь при нажатой кнопке.
Проанализируйте полученные результаты. Отмените выделение.
7. Закройте документ, не запоминая изменения.
Кадрирование изображения – это обрезка изображения (удаление лишних полей, фрагментов окружающей обстановки и т. д.).
Задание № 7. Выполнить кадрирование изображения. 
[image: ]1. откройте файл скамейка.jpg;
2. выберите инструмент Обрезка –               , курсор примет такую же форму, как пиктограмма на кнопке инструмента, нажать ЛКМ;
3. обведите штриховой рамкой изображение, которое необходимо оставить – котёнка;
4. отпустите кнопку мыши.
Изображение будет окружено штриховой рамкой с маркерами. Маркеры дают возможность изменить (уменьшить, увеличить или повернуть) выделенную область. Для завершения процесса кадрирования надо:
1) поместить курсор внутрь выделенной области;
2) Дважды щелкнуть мышью.
Сохраните файл под названием Котенок. jpg.
Задание № 8. Копирование и трансформация.
1. Откройте файл зима.jpg.
2. Выберите инструмент Магнитное лассо и выделите с его помощью фонарь.
3. Копируем выделенную область – CTRL + C. Изображение будет занесено в буфер обмена.
4. Выполните вставку – нажмите клавиши CTRL + V. Никаких внешних изменений не видно.
[image: ]Однако на картинке – 2 фонаря.
5. Выберите инструмент Перемещение
6. Укажите курсором мыши фонарь, нажмите ЛКМ и, не отпуская клавиши, перемещая мышь по столу – перетащите фонарь к двери дома.
7. Выберите инструмент Магнитное лассо и выделите с его помощью перемещённый фонарь. Нажмите клавиши CTRL + X чтобы его удалить.
8. Нажмите клавиши CTRL + V чтобы вернуть фонарь.
9. Выберите Редактирование  Трансформирование  Деформация – фонарь (выделенный участок) будет помещён в рамку со множеством маркеров.
10. Растяните рамку (примените действие).
11. Поверните область – наклоните фонарь.
Нажмите клавишу ENTER для подтверждения трансформации (или ESC для её отмены). 
Задание № 10.
Выделите бабочку, выбрав наиболее подходящий инструмент выделения (файл бабочка.jpg). Создайте несколько копий бабочек, уменьшите их и поверните в разных направлениях.
Задание № 11.
Рядом с котенком (файл скамейка.jpg) разместить его уменьшенную копию.
Замечание. Чтобы сохранить у котят пушистую шерсть, необходимо воспользоваться  командой растушевки.

Практическая работа №3. Маски и каналы
Маски и каналы
Маска — это трафарет, наложенный на изображение. Фрагмент изображения, оказавшийся в отверстии трафарета, может подвергаться любым изменениям, а область, покрытая полупрозрачной пленкой, надежно защищена от редактирования.
Маска используется для уточнения контура выделяемой области. Закрашивание черным цветом расширяет полупрозрачную пленку, сокращая тем самым выделенную область; а закрашивание белым стирает пленку, в результате чего выделенная область увеличивается.
Режим быстрой маски — режим создания маски одноразового применения. Чтобы использовать маску многократно, ее следует сохранить.
Канал маскирования (альфа-канал) — область памяти для хранения маски.
Панель Channels (Каналы) используется для работы с каналами. На ней отображается информация о каналах активного документа.

Корректировка выделения в режиме быстрой маски
Задание № 12. Перейти в режим быстрой маски.
1. Открыть файл 03-04-s.jpg.
2. Выбрать инструмент Лассо.
3. Приблизительно выделить очертания цветка (постарайтесь, чтобы граница выделения  проходила внутри цветка).
4. Щелкнуть на пиктограмме быстрой маски                         на панели инструментов.
Теперь на экране отчетливо виден только выделенный фрагмент, а маскированная (защищенная от изменений) область покрыта полупрозрачной пленкой.
Сейчас необходимо так отредактировать маску, чтобы она четко выделила цветок. Подходящий цвет маски облегчит работу.
Задание № 13. Изменить цвет и уровень непрозрачности быстрой маски.
1. Дважды щелкнуть на пиктограмме быстрой маски на панели инструментов.
2. Появится диалоговое окно Параметры быстрой маски.
3. Щелкнуть на цветном квадрате, который представляет собой образец цвета быстрой маски.
4. Появится диалоговое окно Выберите цвет маски.
5. Выбрать новый цвет для быстрой маски, например голубоватый оттенок.
6. Нажать кнопку Да.
7.Установить значение Непрозрачность, равное 40% (значение непрозрачности следует задавать так, чтобы под маской четко просматривалось изображение).
Цвет  и уровень непрозрачности маски изменятся.
8. Щелкнуть на пиктограмме быстрой маски на панели инструментов.
Цветок будет выделен ярко, а остальная область изображения будет под прозрачной плёнкой назначенного цвета.
Следующая задача заключается в том, чтобы уточнить маску  в соответствии с контуром выделяемой области.
Задание № 14. Уточнить выделение в режиме быстрой маски. 
Продолжим работу с этим же файлом. 
Установим основной и фоновый цвета по умолчанию.
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1.  Щелкнуть на пиктограмме Основной и фоновый цвета по умолчанию на панели инструментов. Выбрать инструмент Ластик.
2. Выбрать размер кончика Ластика 
на панели свойств Параметры инструмента. 
Для этого:
а) щелкнуть на панели свойств на ▼ рядом со значком кисти Откроется окно со стандартным набором образцов кистей 
б) щелкнуть на пиктограмме с подходящим размером. 
3. Перейти в окно изображения.
4. Увеличить изображение цветка.
5. Расширить выделенную область, стирая полупрозрачную пленку с цветка.
Возможно, для более точного определения маски придется увеличить изображение несколько раз. Если в процессе работы вы перешли за границу выделения контура цветка, то воспользуйтесь кистью для уменьшения выделенной области:
а) выберите инструмент Кисть.
б) выберите размер кончика Кисти на панели свойств.
в) перейдите в окно изображения.
г) уменьшите выделенную область, рисуя кистью и тем самым расширяя площадь полупрозрачной пленки. Если, увеличивая полупрозрачную пленку, вы заступили за контур цветка, то нужно снова выбрать Ластик и стереть пленку. Таким образом, в результате попеременного использования Кисти и Ластика, выделенная область будет в точности соответствовать форме цветка.
[image: ]6. Переключиться в стандартный режим, щелкнув мышью на пиктограмме редактирования в стандартном режиме 
Теперь граница выделения выглядит аккуратнее. Будьте осторожны! Случайный щелчок мышью может уничтожить результаты вашего труда. Если же вы недовольны результатом своей работы, снова перейдите в режим быстрой маски и подправьте выделение
Сохранение выделенной области в качестве маски
Задание № 15. Сохранить выделение как маску в канале. Работаем с тем же файлом – у нас выделена область цветка 
1. Выбрать панель Каналы.
По умолчанию эта панель находится на экране. Если по какой-либо причине вы ее не увидели, нужно выполнить команду Окно  Каналы.
2. Выполнить команду Выделение  Сохранить выделенную область.
Появится диалоговое окно Сохранить выделенную область. В списке Документ уже указано имя документа, а в поле Канал — вариант Новый. Это означает, что новый канал будет сохранен в указанном документе.
3. В строке Имя ввести Аlpha1 
4. Щелкнуть на кнопке ОК.
На панели Каналы появился еще один канал — Alphal. Следующий канал получит имя Alpha2 и т. д.
5. Выполнить команду Снять выделение – CTRL + D.
Пиктограмма «глаз» в левом вертикальном ряду панели означает, что канал видим. Щелкая на этих пиктограммах, можно прятать и показывать связанные с ними каналы.
Чтобы увидеть результат работы, загрузим границу выделения из канала маскирования
Загрузка сохраненного выделения
Задание № 16. Загрузить границу выделения из канала.
1. Сделать активной строку совмещенного канала RGB на панели Каналы.
2. Сделать невидимым канал Alphal.
3. Выполнить команду Выделение  Загрузить выделенную  область.
Откроется диалоговое окно Загрузить выделенную область. 
4. Выбрать Alphal в списке Канал. 
5. Щелкнуть на кнопке ОК.
Граница выделения снова появится на экране.
Задание № 17. Изменить название канала.
1. Дважды щелкнуть на строке канала на панели Каналы.
Имя канала будет обозначено маркером с курсором – введите новое имя ASD.
2. Щелкнуть на кнопке ОК.
Упражнения для самостоятельной работы
Упражнение 1
1. Выделить (приблизительно) бабочку (файл бабочка.jpg), используя инструменты выделения и режим быстрой маски.
2. Сохранить выделение в канале.
3. Отменить выделение.
4. Загрузить выделение из канала.
Упражнение 2
1. Выделить яблоко, персик и банан (файл фрукты-3D.jpg) любым способом.
2. Сохранить каждое выделение в качестве маски.
3. Всем каналам присвоить содержательные имена.
4. Загрузить выделения из каналов в следующем порядке: персик, яблоко, банан.
Практическая работа  Замена фона в Photoshop
Полная или частичная замена фона выполняется очень часто при обработке фотографий. Программа Adobe Photoshop отлично справляется с этой задачей.
Замена неба на фотографии в Photoshop  выполняется очень часто. Это просто частный случай замены фона. Небо на фотографиях очень часто получается невыразительным, белым в ясный солнечный день. А в непогожий и пасмурный оно и так серое. И на снимке блеклое.
Для изменения фона в Photoshop (или части фона - неба) надо разделить изображение на две или больше частей, каждая из которых затем размещается в отдельном слое и исправляется или заменяется на другое, более подходящее изображение.
Небо нужно аккуратно отделить от остального изображения, удалить его или скрыть маской, а вместо него вставить небо из другой фотографии или просто нарисовать его с помощью градиентной заливки, например. Не забудьте при этом обязательно оставить копию исходного изображения на тот случай, если все испортите.
Рассмотрим несколько вариантов замены неба в Photoshop.
Простая замена неба на фотографии
Прежде чем заняться заменой неба в Photoshop, нужно проанализировать изображение.
[image: Описание: замена фона]
Фотография была сделана вечером, выглядит все как-то мрачновато. Небо на снимке везде одинаково серое, здание намного темнее неба, четко выделяется на его фоне и по тону и по цвету. Как удалить небо? Прежде всего, его нужно выделить. В этом случае поможет Волшебная Палочка. Создайте копию слоя, нижний слой сделайте невидимым (пусть будет на всякий случай – вдруг пригодится).
Выберите на панели инструментов Adobe Photoshop Волшебная палочка, установите параметр Допуск 20 или немного больше или меньше, щелкните палочкой на небо и выделите его. Если сейчас удалить выделенную область, контуры оставшейся части будут неестественно четкими. Нужно немного размыть выделение. Выберите Выделение – Модификация – Расширить 2 пикселя, а затем Выделение – Модификация – Растушевка 1 пиксель.
[image: Описание: замена фона]
Нажимаем клавишу Delete и очищаем фон. На фотографии осталось только здание, вместо неба прозрачная область. Можно вставить синее небо из другой картинки или нарисовать его, залив сине-голубым градиентом.
Для этого создайте новый слой под слоем со зданием и залейте его сине-сиреневым градиентом цвета вечернего неба. Можно скачать небо. Если вы не знаете, как работать с градиентом, читайте Градиент в Photoshop .
[image: Описание: замена фона]
Так смотрится намного лучше. На фото ранние сумерки. Фонари уже горят. Хороший вечер.
[image: Описание: замена фона]
Замена неба закончена и, если вы довольны результатом, объедините слои изображения.
Возьмем другую фотографию, этот случай немного сложнее предыдущего:
[image: Описание: замена фона]
Здание на фотографии бело-голубое, почти сливается с небом, небо неоднородное, есть облачность в дымке. Выделить по цвету инструментом Photoshop  Волшебная палочка будет очень сложно, выделение будет захватывать часть здания, разве что выставить параметр Допуск очень маленький 2-3. Потом выделять и удалять небо по частям. Есть в данном случае лучший вариант – здание имеет четкие прямолинейные контуры и, воспользовавшись инструментом Многоугольное или Полигональное лассо, можно легко выделить здание.
Создайте копию слоя, нижний слой сделайте невидимым. Аккуратно выделите здание инструментом Photoshop  Лассо. Затем выполните команду Выделение – Инверсия – станет выделенным небо.
[image: Описание: замена фона]
Небо удалите. Осталось здание на очищенном прозрачном фоне. Создайте новый слой под слоем со зданием.
Чтобы вставить красивое небо из другой фотографии, нужно открыть эту фотографию в Photoshop. Выделите в ней инструментом выделения Прямоугольник небо или его часть, скопируйте, а затем перейдите в наше изображение со зданием и вставьте в только что созданный новый слой.
Инструментом перемещения передвигайте небо так, чтобы выглядело естественно. Если размеры вставленной части не совпадают, воспользуйтесь Редактирование –  Трансформация –  Масштаб.
[image: Описание: замена фона]
Когда замена фона закончена и вы довольны полученным результатом, - объединяйте слои изображения.
[image: Описание: замена фона]






СОЦИ, 07-12 февраля,  почта tat_2211@mail.ru
Тема 16. Пакет Nero
	Обзор программ, входящих в пакет Nero. 

	ПР «Создание аудио-диска» 

	ПР «Конвертирование звуковых файлов средствами Nero»


Составные пакета Nero 
С помощью программы Nero можно записывать диски практически всех существующих в настоящее время стандартов, а именно диски с данными, аудио- и видеофайлами (в форматах Video CD и Super Video CD). Она позволяет, как копировать, так и создавать свои собственные компакт-диски, писать одновременно на несколько устройств, непосредственно преобразовывать МРЗ и WMA-файлы в аудиотреки и т. д.
Главные компоненты «Nero»:
· непосредственно сама программа записи лазерных дисков «Nero Burning ROM»;
· средство для ускоренной организации записываемых проектов «Nero Express»;
· утилита для создания видеодисков «Nero Vision Express»;
· утилита для создания саундтреков «Nero Sound Trax»;
· видеопроигрыватель «Nero ShowTime»;
· медиаплеер «Nero Media Player»;
· музыкальный редактор «Nero Wave Editor»;
· эмулятор CD-привода «Nero ImageDrive»;
· утилита для создания резервных копий дисков «Nero BackltUp»;
· редактор обложек дисков «Nero Cover Designer»;
· утилита для пакетной записи CD-RW «InCD»;
· утилита для тестирования CD или DVD-приводов «Nero CD-DVD Speed»;
· утилита для контроля скорости вращения CD или DVD-приводов «Nero DriveSpeed»;
· утилита для сбора информации о системе «Nero InfoTool»;
· специальный навигатор с общим меню для всех перечисленных инструментов и приложений, объединяющий в себе все возможности программы «StartSmart».

Практическая работа. Создание аудио- диска из любых песен, мелодий.
Nero Burning ROM – создание Audio CD 
AUDIO CD это первый созданный формат компакт дисков, основан он в 1980 году совместными усилиями фирм Sony и Philips. 
[image: ]Этот стандарт занесен в “желтую книгу”, определяющей формат хранения цифрового звука на компакт диске. Согласно данному формату на стандартный компакт диск может быть записано не более 99 звуковых треков, длительностью не менее четырех секунд каждый. Перед первым треком должна находиться пауза не менее двух секунд.
Изначально емкость звукового диска измерялась в минутах и до сих пор на многих компакт дисках имеются два обозначения в минутах и в мегабайтах. 
Практически все созданные CD - R легко читаются в обыкновенных музыкальных центрах, CD плеерах, иное дело обстоит с многоразовыми дисками   CD - RW , записываются они также легко, как и обыкновенные CD - R , а вот читаются… 
Дело в том, что отражающая способность перезаписываемых CD намного ниже обыкновенных и для их успешного воспроизведения нужна аппаратура выпущенная (именно выпущенная,  а не купленная) в последнее время. 
Окно проекта
В любом случае, если Вы пишите диски для себя, то можно вопрос с записью на CD - RW легко решить простой пробой – записать музыку и попробовать прослушать ее в Вашем музыкальном центре, если работает – хорошо, если нет, то значит Вам доступны для записи только обыкновенные заготовки CD - R . 
А теперь перейдем непосредственно к созданию Audio CD . Запускаем  Nero Burning Rom:
Из списка типов диска (слева) выбираем Audio CD, появляется окно проекта.  А пока нажимаем кнопку «Новый».  
Появляется главное диалоговое окно:
 [image: ]
  Для создания проекта необходимо захватить и перетащить мышкой музыкальные файлы из правой части окна в левую. Nero автоматически переведет Вашу музыку в стандартный формат cda. Также файлы можно переносить не только из открытого проекта Nero а из любого открытого окна Windows , из любой папки. Программа может преобразовывать следующие форматы MP3, mp3PRO, WAV, VQF, WMA, а писать на диск неподдерживаемый формат программа откажется и выдаст соответствующие предупреждение.
Главное окно содержит две функциональные кнопки: воспроизведение и редактирование. Назначение первой кнопки ясно из ее названия - можно прослушать [image: ]записываемый файл, вторая вызывает встроенный звуковой редактор. 
Изменился индикатор заполнения диска в отличии от диска с данными его объем показан не в мегабайтах а в минутах.
В настоящее время  многие музыкальные центры поддерживают формат  CD - Text , не оставлено это без внимания разработчиками программы Nero . Записать этот формат на диск не составляет труда, достаточно на выбранной дорожки щелкнуть правой кнопкой мыши и в выпадающем меню выбрать пункт «свойства»:
В появившемся диалоговом окне, на вкладке свойства дорожки заполняем поля: 
· Заглавие ( CD - Text ) – название звукового трека (английским шрифтом). 
· Артист ( CD - Text ) – исполнитель (английским шрифтом). 
· Устанавливаем размер звуковой паузы. 
Нажимаем кнопку «Применить» и «ОК» и так для каждой звуковой композиции.
Следует отметить, что если звуковая композиция изначально имела название и имя исполнителя, то эти данные, в нужные нам поля переносятся автоматически. 
Наличие на аудио диске данной информации ни коем образом не повлияет на качество звучания фонограмм независимо от того поддерживает проигрыватель CD - Text или нет. И еще одна особенность такой диск пишется только в режиме DAO .
Вкладка Инфо:
[image: ]
Это окно содержит:
· Размер – показан объем данных подготовленных для записи на диск. Размер показан как в минутах, так и в мегабайтах. Особый интерес может вызвать размер данных в мегабайтах – в нашем случае размер данных более 800 Мб. Как это происходит? Все дело в том, что при записи аудио на диск пишется намного меньше служебной информации и за счет этой разницы на стандартном диске появляется дополнительное пространство для записи аудио дорожек.
· Число дорожек – количество музыкальных композиций.
[image: ]Вкладка Audio CD :
Единственное, на что следует обратить внимание на этой вкладке это опция «Запись CD - Text на CD ». Если CD - Text нам нужен, то отмечаем эту опцию, если нет – то нет.
· Заглавие ( CD - Text ) – пишем название аудио диска.
· Артист ( CD - Text ) – пишем исполнителя, если исполнителей несколько (пишем сборник, озвученные тексты и.т.д.) то окно можно заполнить любым подходящим текстом.
 Если не хотите в дальнейшем получить неожиданные сюрпризы, то данные окна необходимо заполнять английскими буквами.
Остальные окна не так важны и их можно оставить пустыми. 
 Для записи аудио дисков существуют определенные особенности.
· Определить максимальную скорость - определяет максимальную скорость с которой Ваш привод способен записать диск. Отказываемся от этой опции - нужную скорость установим самостоятельно.
· Имитация - это своеобразный тест, программа имитирует запись на диск, но в отличии от реальной работы не включает лазер. Вдвое увеличивает время записи. Если Вы уверенны в своем приводе эту опцию можно не включать.
· Запись - пишет диск.
· Финализировать CD - если выбран метод записи Disk-at-Once, то опция не активна и диск финализируется автоматически. При записи методом Track-at-Once опция активна, но если диск не "закрыть" то впоследствии его можно и не прочитать на Вашей музыкальной аппаратуре. Вывод - обязательно финализируйте диск!
· Скорость записи - качество записанного диска напрямую зависит от этого параметра, и от качества чистого диска. При скорости 2х-4х диск запишется хорошо, даже на заготовках " no name ". На фирменных дисках эту скорость можно поднять до 8х-16х. Вообще, если при прослушивании музыки слышны посторонние шумы - то, возможно в этом виновата скорость записи, снижайте ее в два раза.
· Метод записи - записывать музыку предпочтительней методом Disk-at-Once, но при выборе стратегии ссылок или устройствозависимой стратегии запись возможна только в Track-at-Once. Не в пользу метода Track-at-Once говорит еще то, что при данном методе невозможно записать CD-text.
· Число копий - по желанию.
· Исп. Много рекордеров – перед записью программа предложит выбрать какой именно привод использовать для записи.
· Защита от опустошения буфера ( Buffer under-run protection ) – она реализована в современных приводах. Смысл ее в том, что если в процессе записи прервался поток данных (для старых приводов это гарантированный брак записи), то после его появления лазер продолжает записывать диск точно с того места, где запись была прервана.  Обязательно отмечайте эту опцию.
 Нажимаем запись и через несколько минут получаем готовый аудио диск.
Конвертирование звука пакетом  Nero
Nero Wave Editor - конвертер аудио файлов
[image: ]
Nero Wave Editor - специальная функция программы, которая позволяет легко конвертировать аудио-файлы и даже извлекать звуки из видео записей. 
[image: ]С помощью Nero можно конвертировать аудио в mp3 и другие форматы (Mp4, Mp4a, aac, aif, wma, ogg, wave, wav и т.д.) Она позволяет не только задавать форматы конвертирования, но и изменять частоты, добавлять эффекты, влиять на уровень шума, производить улучшения качества звука, влиять на стерео и моно режимы воспроизведения, производить запись звука, нарезать аудио файл, воспроизводить любой трэк и многое другое.

Конвертирование: открыть файл одного формата, сохранить в другом.
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Для применения эффектов: 
[image: ]
Главное окно пользовательского интерфейса программы Nero Wave.
Указанный потенциал программы Nero Wave Editor дает возможность гибкого редактирования аудиофайлов:
1. Изменения темпа (скорости) воспроизведения (Tools → Time Correction).
2. Заданного изменения огибающей уровня звука (Volume→ FadeIn, Volume FadeOut).
2. Внесения стандартных эффектов в звучание (Effects → Delay, Flanger, Chorus, Reverb).
3. Тонкое регулирование качества звука и применение шумоподавления (Enhancement High Frequence Correction, Noise Reduction).

Типовые задания на редактирование аудиоданных:
1. Изменение  воспроизведения  темпа  аудиоклипа  (получение  ‘голоса Буратино’  или  ‘утрированного  баса’).  Провести  подобные  преобразования методом Tools → Transpose (использовать настройки ‘Helium Speech’ и ‘Monster Speech’).
2. Настройка динамических свойств воспроизведения (зависимость выходного уровня сигнала от уровня входного, Tools → Dynamic Processor). •Добавление  эффекта  однократного  эха (Tools → Delay),  ‘дрожания’ (Tools → Flanger), хорового исполнения (Tools →Chorus), реверберации (Tools → Reverb).
3. Понижение уровня шумов аудиоклипа (Enhancement→ Noise Reduction).

Практическая работа
1. Преобразовать файлы из Задания №8 (папка Исходные) формата .wav и ogg в формат mp3.
2. Добавить любой эффект и сохранить файл с названием эффекта.
Тема 17. Плееры
	Плееры. Обзор программ компьютерных плееров

	Windows Media Player. 

	КМР-плеер: установка, интерфейс, настройка. 

	ПР «Настройка КМР-плеера, создание плей листа»



1. Лекции:
1. Обзор программ компьютерных плееров. Посмотреть в интернете.
2. Windows Media Player
3. КМР-плеер: установка, настройка, интерфейс.
4. Плей-лист.
2. Практические работы.
3. Ответы на вопросы.

Windows Media Player
Открыть ссылку в интернете. Выписать возможности программы.
http://inform-school.ucoz.ua/index/proigryvatel_windows_media/0-255

KMPlayer
The KMPlayer (КМП плеер) за последние 9 лет стал стандартным проигрывателем видеофайлов для миллионов компьютеров российских и зарубежных пользователей. Даже после выхода Windows 10, операционная система не научилась одинаково качественно и без тормозов воспроизводить видеоролики устаревших (avi, 3gp) и современных (4K, VR) форматов - KMPlayer умеет это делать без установки дополнительных кодеков и ковыряния в настройках.
 Кстати о кодеках - входящий в комплект с проигрывателем набор обновляется автоматически вместе с программой, проверка доступности обновлений происходит после каждого запуска в фоновом режиме. Также в настройках есть опция выбора кодеков сторонних разработчиков, установленных на компьютер отдельно от плеера.
В последнюю версию KMPlayer добавлена поддержка подключения шлема (очков) виртуальной реальности HTC и функция просмотра видео в формате 360 градусов.
Характеристика интерфейса воспроизведения и настроек KMplayer
[image: ]Как и ранее в программе KMplayer русская версия содержит верхнюю панель инструментов элементами управления окном, а также нижний бар. Вверху расположены типичные и знакомые элементы: сворачивание окна, выключение плеера, а также переход в минималистический режим. При этом внизу располагаются локации для отображения информации о проигрываемом файле: процент прогресс, таймер обратного и положительного хода, эквалайзер и полоса прогресса. Выше ее располагаются элементы управления проигрыванием: здесь имеются функции перехода к следующему треку плейлиста, кнопки открытия композиций из проводника Windows, а также настройки.
Этим плеером можно вопроизводить любой видеоматериал, например то, что снимают системы видеонаблюдения. 
KMP плеер полностью на русском языке, поэтому в его работе и настройках русскоязычному человеку будет легко разобраться. В главном его окне можно изменить такие параметры как яркость и контрастность картинки, настройки эквалайзера, скорость воспроизведения и синхронизацию субтитров – все это можно сделать через всплывающее окошечко не заходя в основные настройки.
Настройки изменения интерфейса располагаются в привычном меню, состоящем из двух колонок. Левая является ориентирующей и показывает пользователю разделы настроек. Они организованы в виде древовидной структуры. При этом активация элемента настройки в левом меню выводит на правую сторону спектр опций, характерных для определенного раздела конфигураций.
Возможность создания закладок и быстрый переход по ним, захват скриншотов из видео с заданной периодичностью и установка кадра из видео в качестве обоев рабочего стола, автоматическое выключение компьютера в заданное время – это лишь немногие их огромного количества доступных возможностей. 
Установка и настройки KMPlayer
[image: ]В поисковике Яндекс скачать русский KMP. Для установки нужно запустить файл, выбрать язык. Если в данной версии нет русского языка, то можно установить английский, а потом можно скачать еще и русификатор, и русифицировать его после установки.
Когда начнется процесс установки, то нужно соглашаться с теми пунктами, которые показывает программа по умолчанию. Когда установка плеера KMP закончена, можно его запустить и посмотреть. 
Теперь следует убрать плеер, который по умолчанию накладывается поверх всех окон. Сделать это очень просто. Наводим мышку на плеер, нажимаем правую кнопку и выбираем из выпавшего меню пункт: «Отображение» и в следующем выпавшем меню, выбираем почти в самом низу: «Поверх остальных окон», и ставим галочку «Никогда».
Еще  установить, в этом же окне галочки на «Запрет экранной заставки» и чуть ниже «Скрывать курсор мыши». Теперь все правильно и во время того, когда вы просматриваете какой-то фильм, у вас не будет выскакивать заставка от Windows, а курсор мышки будет автоматически исчезать.
Настройка клавиатуры 
Снова вызываем меню с помощью правой кнопки: «Настройки»  — « Конфигурация». У вас выскочит окно. В этом окне вам нужно нажать на «Общее» (верхняя строка)  И выбрать «Клавиатура/мышь». См. рис.
Теперь зададим действия, которые будут выполняться с помощью определенных кнопок. Для этого выбирайте нужные вам пункты, и делайте все под себя. Здесь сами смотрите, как вам будет удобнее, и я не думаю, что у кого-то это вызовет затруднения, все просто.
Для установки размера плеера во время перехода на новый файл кликаем правой кнопкой мыши, и выбираем строчку «Отображение», затем «Окно в начале воспроизведения», устанавливаем «Половинный размер». Теперь во время смены видео KMP будет очень незначительно изменять размер, ну а в полноэкранном режиме плеер  KMPlayer переключается с файла на файл без изменений.
Файлы в папке можно запускать   тремя способами:
· Плеер будет открывать только выделенные файлы. 
· Так же  общее открытие похожих файлов; 
·  И конечно же открытие всех файлов в папке. 
Чаще всего используется 3-тий способ, потому что он более универсален. Для того чтобы настроить этот способ открытия файлов кликаем правой кнопкой на мышке и выбираем «Воспроизведение»  «Способ открытия файлов» «Открытие всех файлов в папке». Еще можно установить галочку в пункте «Открывать след./пред. файл в папке». Теперь вам будет достаточно запустить, например, третий по счету видеоклип из папки, а потом с помощью PageDown и PageUp передвигаться по другим файлам, проигрыватель KMP будет их автоматически запускать и делается это все без задержки, быстро и плавно.
Как установить плеер KMP плеер по умолчанию
Выберем любой видео файл, например, nebo.avi, кликаем по нему один раз, потом нажимаем правую кнопку мыши и в открывшемся меню выбираем «Открыть с помощью», нажимаем «Выбрать программу», вы увидите окно выбора программы, через которую можно отрыть файл. Если в этом списке не будет нужной нам KMP, тогда добавляем его с помощью кнопки «Обзор». Плеер установлен и находится на диске «С»: в папке Program Files\The KMPlayer. Но прежде чем нажать на «ОК», а для начала поставьте галочку в пункт «Использовать выбранную программу для всех файлов такого типа», и теперь жмем на «ОК».
Для того чтобы поставить плеер по умолчанию и для других файлов, нам будет нужно выбрать файлы с разными расширениями (wmv, .mpg, mp4 и т.д.) и сделать с ними так же, как делали для nebo.avi. Я не советовал бы, использовать этот плеер, для прослушивания музыкальных файлов, так как есть отличные плееры специально для музыки, например — AIMP.
Как сделать скриншот нужного кадра с помощью этого проигрывателя.
KMP имеет возможность сделать скриншот (снимок экрана) нужного кадра проглядываемого видео. Ставим на паузу на нужном кадре, если нужно  немного перемотать изображение на нужный момент при помощи стрелок на клавиатуре. Скриншот делается комбинацией клавиш Ctrl+E, но не забудьте указать имя файла и место сохранения. Если не укажите место, тогда скриншот автоматически сохранится в папку с KMP по пути: «С» Program Files\The KMPlayer\Capture\имя скриншота, пользуйтесь комбинацией Ctrl+A.
Возможности проигрывателя KMPlayer
· Проигрывание потокового видео и аудио – т.е. можно смотреть фильмы и слушать музыку сразу из Интернет, не скачивая к себе на компьютер
· поддержка видеоформатов AVI, ASF, WMV, AVS, FLV, MKV, MOV, 3GP, MP4, MPG, MPEG, DAT, OGM, VOB, RM, RMVB, TS, TP, IFO и NSV; 
· возможность поставить дополнительные кодеки
· Проигрывание недокачанных и поврежденных файлов. Можно скачать начальный фрагмент фильма и посмотреть его качество.
· быстрый доступ к основным настройкам картинки, звука и субтитров через прозрачную панель инструментов; 
· Поддержка субтитров различных форматов, возможность редактировать субтитры.
· Можно проиграть любой отрезок материала (надо задать начальную и конечную точку)
· непрерывное воспроизведение сериалов из одной папки, запоминание места, на котором остановился просмотр перед отключением KMPlayer; 
· смена языковой дорожки и встроенных субтитров у совместимых видеороликов, подключение внешних субтитров из файла (их можно скачать с интернета, получить вместе с фильмом на диске или даже написать самому) к любому видео; 
· поддержка сохранения и чтения настроек из файла конфигурации - KMPlayer в этом случае работает как портативное (Portable) приложение; 
· настройка яркости, четкости и насыщенности картинки, включение постобработки воспроизводимого видео (актуально для старых avi фильмов весом 700 МБ или нечетких документальных записей); 
· интерфейс проигрывателя переведен на 40 языков, русская версия KMPlayer работает без установки дополнительных русификаторов; 
· есть настройка выключения компьютера после завершения просмотра фильма (для тех, кто любит засыпать перед экраном); 
· поддержка смены языка озвучки воспроизводимого фильма; 
· расширение функционала с помощью установки родных и сторонних плагинов (поддерживаются плагины от программы Winamp). 
Преимущества KMPlayer
1. Отсутствие необходимости настраивать проигрыватель после установки для начинающих  пользователей компьютера, и одновременно присутствие тонкой настройки каждого параметра и видео фильтров для профессионалов; 
2. Воспроизведение фильмов напрямую с DVD дисков, из папки проводника Windows, по URL ссылке из интернета или с FTP сервера; 
3. Просмотр поврежденных и недокачанных роликов; 
4. Одинаково низкое потребление системных ресурсов при запуске на операционных системах с разрядностью 32 и 64 bit. 
5. не грузит операционную систему и компьютер; 
6. способен громко воспроизводить звук в фильмах без ощущаемой потери качества (актуально для ноутбуков с тихими встроенными динамиками); 
7. благодаря функции «всегда на переднем плане» можно включить воспроизведение видео в углу монитора и параллельно заниматься другими делами на компьютере. 
Недостатки
· не очень удобен для прослушивания музыки, больше заточен под видео; 
· настройки для неопытных пользователей могут показаться слишком сложными, поэтому без необходимости в них лучше не лезть. 
Почему KMPlayer для Windows так популярен?
Основная причина популярности корейского KMP Player на Windows – поддержка большинства известных форматов видео и самое главное – кодеков, с помощью которых данные видео были закодированы при их создании. Благодаря этому проигрыватель может воспроизводить не только самые новые фильмы в HD или 4K разрешении, но и старые avi файлы кустарного производства. И все это доступно «из коробки».
В Windows 10 хоть и встроены последние версии драйверов и некоторые кодеки, но ее стандартный windows media player до сих пор не может воспроизвести то видео и аудио, которое без проблем воспроизводится в KMPlayer.
[bookmark: vozmojnosti][bookmark: download][bookmark: firstHeading]Плей-лист
[bookmark: cite_ref-1]Плей-лист[1] (от англ. playlist — список воспроизведения) — подборка песен, инструментальных композиций для воспроизведения на радио или с помощью медиаплеера.
Также плей-листом называют список композиций, исполняемый артистом на концерте.
[bookmark: toc]
[bookmark: .D0.9F.D1.80.D0.BE.D0.B8.D1.81.D1.85.D0.]Происхождение
Первые плей-листы появились с началом регулярного радиовещания, как и сам термин. В своей изначальной английской трактовке термин мог обозначать не только конкретную программу радиопередачи, но и (в широком смысле) весь набор произведений, который радиостанция имела право транслировать. Составление плей-листа, как правило, происходило путём записи выбранных произведений на магнитную ленту, одного за другим. Впоследствии, записанная лента была основой для радиотрансляции.
[bookmark: .D0.A6.D0.B8.D1.84.D1.80.D0.BE.D0.B2.D1.]Цифровые плей-листы
С появлением персональных компьютеров и цифровых аудиоплееров, стало возможным составлять и сохранять списки воспроизведения в цифровом формате. Цифровой плей-лист хранится в памяти устройства или в файловой системе. При воспроизведении музыки он автоматически обрабатывается, определяя набор и последовательность воспроизводимых произведений. Большинство современных медиаплееров поддерживают как последовательное воспроизведение, так и случайный переход («шаффл»).
Форматы файлов
Существуют форматы плей-листов, разделяются на общепринятые (стандартные) и те, которые разработаны для конкретного медиаплеера. Однако нередко форматы второго типа становятся популярными и стандартными.
В число наиболее популярных форматов для хранения плей-листа входят:
1. [bookmark: cite_ref-2]Advanced Systems Format (.asx) — Windows Media Metafile — XML-подобный формат файла,[2] представленный в Windows Media Player. 
2. B4S — базирующийся на XML формат плейлиста Winamp3. 
3. FPL — плей-лист плеера Foobar2000. 
4. M3U (.m3u, .m3u8) — текстовый файл, изначально появился в Winamp, далее поддержка появилась и в других плеерах. 
5. PLS — формат, используемый первоначально в Light Alloy. 
6. Real Audio Metafile — только для файлов формата Real Audio. 
7. smil — XML-подобный формат, рекомендованный Консорциумом W3C. Распространяется как на аудио, так и на видео-форматы. 
8. VLC — собственный формат плей-листа в VLC media player. 
9. Windows Media Player Playlist (WPL) — список воспроизведения Windows Media Player, начиная с 9 версии. 
10. XSPF — открытый XML-формат, рассчитанный на переносимость и кроссплатформенность. Разработан Xiph.Org. 
11. ZPL — формат плейл-иста в Zoom Player. 
12. AIMPPL, PLC - форматы плей-листов AIMP. 
[bookmark: .D0.A0.D0.B0.D1.81.D0.BF.D1.80.D0.BE.D1.]Распространение
Развитие аудиоплееров сделало возможным обмен плей-листами, их публикацию и переработку. Для упрощения формирования списков воспроизведения можно использовать различные утилиты, такие как AudioGrail и др.
Существуют интерактивные веб-сайты (например, Last.fm и iTunes Store), которые позволяют нескольким пользователям использовать общий плей-лист, либо составить собственный плей-лист на основе опубликованного.
Многие известные люди, такие как Джордж Буш[3] и Бритни Спирс публиковали свои плей-листы.
Ответить на вопросы:
1. Назначение  программ-плееров. Перечислить названия, которые нашли в интернете.
2. Выписать возможности программы Windows Media Player.
3. Интерфейс программы KMPlayer (открыть окно программы и описать назначение основных элементов).
4. Настройка программы KMPlayer.
5. Перечислить основные возможности программы.
6. Определение плей –листа.
7. Записать какие плееры установлены на вашем компьютере.
Практическая работа №1. Установка программы KMplayer, настройка
1. Установить программу KMplayer, скачав ее в интернете.
2. Дополнительно: найти и описать с помощью скриншотов экрана хотя бы один из пунктов:
1. Как смотреть фильмы и слушать музыку сразу из Интернета, не скачивая к себе на компьютер;
2. Как поставить дополнительные кодеки;
3. Как запоминать место, на котором остановился просмотр перед отключением KMPlayer;
4. настройка яркости, четкости и насыщенности картинки;
5. как осуществить смену языка озвучки воспроизводимого фильма.

[bookmark: _GoBack]Практическая работа №2. Создание плей-листа.
Задание. Создать плей-лист из любимых песен (5-10 штук). Отослать в формате плей-листа, сделать скриншот экрана KMplayer.
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14 группа


 


 


Группа 14 Экономика организации


 


Подготовить доклад на тему "Валюты,деньги разных 


стран мира"


 


 


Публикация


 


изучить лекцию «


Социальные сети. Определение. Функции и виды


». Составить 


презентацию по 


теме «


Социальные сети. Определение. Функции и виды


».


 


Лекция находится на сайте училища:


 


Личные странички педагогов 


–


 


Ясницкая М.П. 


–


 


ДО 


–


 


Лекции 


–


 


лекция ««


Социальные сети. 


Определение. Функции и виды


»». 


 


 


 




14 группа     Группа 14 Экономика организации   Подготовить доклад на тему "Валюты,деньги разных  стран мира"     Публикация   изучить лекцию « Социальные сети. Определение. Функции и виды ». Составить  презентацию по  теме « Социальные сети. Определение. Функции и виды ».   Лекция находится на сайте училища:   Личные странички педагогов  –   Ясницкая М.П.  –   ДО  –   Лекции  –   лекция «« Социальные сети.  Определение. Функции и виды »».       

